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i

WARNING

Researchers and managers using ECOTOX for analyses or summary projects should
consult the original publication. This will ensure an understanding of the context of the data
retrieved from ECOTOX.  

ECOTOX attempts to be comprehensive, but due to funding gaps, data from recent
publication years may not appear in the database.  Researchers should conduct literature
searches for additional relevant data to supplement ECOTOX retrievals for PHYTOTOX
and TERRETOX.
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INTRODUCTION

In the development and implementation of ecosystem management decisions there is the
need to establish scientifically credible risk assessments for chemical stressors. 
Ecological assessments are required to characterize and diagnose the relative risk of
chemical pollutants and to predict future risk as a function of environmental management
options. 

ECOTOX (ECOTOXicology Database System) is a comprehensive computer-based
system that provides single chemical toxic effect data for aquatic life, terrestrial plants, and
terrestrial wildlife. This data is useful in developing consistent ecosystem management
decisions within EPA and other Federal, state, local, tribal and international governmental
agencies. ECOTOX provides a means to cost-effectively collect standardized and critically
needed effects data for a wide variety of ecological risk assessments.

ECOTOX, developed at the U.S. EPA MED-Duluth, integrates three previously
independent databases - AQUIRE, PHYTOTOX, and TERRETOX - into a unique system
which includes unique toxicity data derived predominately from the peer-reviewed
literature, for aquatic life, terrestrial plants, and terrestrial wildlife, respectively. The U.S.
EPA Office of Pesticide Program’s Environmental Effects Database (EEDB) toxic effects
data for registered pesticides is also included within ECOTOX.  Not all data published in
the peer review ecotoxicology literature are included in ECOTOX.  You should refer to the
Limitations section of this document to understand test results that are not considered for
inclusion in the database.

AQUIRE, the aquatic toxicology database was developed in 1981.  The aquatic toxicity
data compilation spans the publication years from 1915 through to the present time.  As of  
June 2000, the aquatic data component of ECOTOX contains  181,978 toxicity tests from
13,500 references for more than 6,800 chemicals and4,000 aquatic species. 

Retrieval, review, and encoding of terrestrial plant toxicology literature into PHYTOTOX
began in 1981.  Data are available from the publication year 1926 through to the present
time. Terrestrial animal toxicology literature has been retrieved, reviewed and entered into
TERRETOX since 1983. Data are available from the publications year 1969 to the present
time.   As of June 2000, the terrestrial animal and plant data component of ECOTOX
contains 2,900 publications,  2,306 chemicals and  1,481 terrestrial species.

The EEDB (Ecological Effects Database), U.S. EPA Office of Pesticide Programs, is
integrated into ECOTOX via periodic updates from the Office of Pesticide Programs. The
EEDB includes toxicity data for aquatic and terrestrial life. These data have been reviewed
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and categorized as acceptable for fulfillment of pesticide registration and re-registration
guideline requirements as explained under FIFRA Subdivision E, Parts 158.145 and
158.150. 

Researchers or managers using ECOTOX for analyses or summary projects
should consult the original scientific paper to ensure an understanding of the
context of the data retrieved from ECOTOX.  

For more information on the ECOTOX database contact:
Scientific Outreach Program
U.S. Environmental Protection Agency
Office of Research and Development
National Health and Environmental Effects Research Laboratory
Mid-Continent Ecology Division (MED-Duluth)
6201 Congdon Boulevard
Duluth, Minnesota 55804
Telephone: 218-529-5225
Fax: 218-529-5003
E-mail: ecotox.support@epa.gov
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GETTING STARTED

Access

To access the ECOTOX Web site, you will need a computer equipped with a World Wide
Web browser and a means of connecting to the Internet.  Start your browser and type in the
Internet address http://www.epa.gov/ecotox/ and you will be connected to the ECOTOX
home page.  The page provides a general overview of the ECOTOX database with links to
System Documentation, Frequently Asked Questions (FAQ), and Limitations to the
System. The home page allows you to select one of two ways to search ECOTOX. The
Quick Search form allows a simple search for a limited number of chemicals, species,
effects and publication years. The Advanced Search is menu driven and uses navigation
links to direct you through multiple search criteria pages. The Advanced Search utilizes all
search and output features.
 
If the COMMENTS option does not work, check your browser software to ensure that you
have defined your E-mail address and server.

To conduct a search, click on either the “Use ECOTOX Quick Search” or “Use ECOTOX
Advanced Search” option.  The search page will then load.            

   
Cookies

The ECOTOX site stores your last search criteria for seven days upon exiting.  It can only
store the search if you accept cookies.  The use of cookies in the ECOTOX site is
optional.  After you run a search, our site will place a cookie (or ask, depending how your
browser is set up) on your browser which stores the last search strategy used. When you
leave ECOTOX and wish to come back to the last search you performed, the computer will
recognize this and bring up the search conditions.  You may choose to run the search if you
wish. 

Cookies are information stored on your personal web browser.  The web normally has no
way of telling if you had previously been to the web site.  The use of cookies allows the site
you are accessing to “remember” you.  If you wish to learn more about cookies, please
check http://www.whatis.com.

ECOTOX LIMITATIONS

Data Limitations



ECOTOX 2.0 User Guide September, 2000

4

The following restrictions are placed on published data.  Data not satisfying these
requirements are excluded from the ECOTOX databases:

• The author(s) must report valid species and chemical information. If the ECOTOX staff
cannot verify the species Scientific and common names or locate the chemical's
Chemical Abstract Services (CAS) Registry number and a Collective Indices name, the
data record is not included in the database. 

• Only single chemical exposures are included in ECOTOX, therefore results for
chemical mixtures are excluded.  

• The author(s) must identify the exposure duration associated with the observed effect.

• Bacteria and virus studies are not included.  

• The author(s) must report either a chemical concentration or application rate and the
associated observed effect. 

• In vitro exposures are not included in the ECOTOX database. 

• Toxicity test data for chemical exposures where only sediment concentrations are
reported are excluded from the AQUIRE database. 

• In general, tests conducted with petroleum (fuel oils) products are excluded from
ECOTOX.

Version 2.0 Limitations

The following limitations exist for the Web version of ECOTOX.  

C The ECOTOX Search page requires that your browser support JavaScript and this
feature must be activated in your browser preferences. 

C The ECOTOX Web page does not function properly when using Windows 3.1.

C The ECOTOX Web site supports Netscape Navigator 4.02 (or higher) and Explorer 4.x
releases. Older browser versions are not supported and will require upgrade.

C Internet Explorer 5.0 has some problems in the lower versions. Please use Build
5.00.2919.6307 (Under Help->About Explorer) or higher. Upgrade if necessary.
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C There is a maximum number of 500 terrestrial and/or 5000 aquatic records that can be
retrieved in one browser viewable search.  The delimited export file will retrieve up to
10,000 terrestrial or aquatic records.

CC If your computer has a smaller monitor (e.g., 13"), you should increase your resolution
using your PC setting and/or your web browser font to fit more information on your
screen.

ONLINE HELP

Press the help icon on the Web search page at any time for online help.  Prior to using
ECOTOX, you should take some time to familiarize yourself with these documents:

C How to Search  Find information on how to navigate through a search and produce
output reports. 

C Search Planner  View or print this form to assist you in planning your search strategy.  

C Data Fields Definitions  Locate definitions of the data fields found in ECOTOX.  

C Code List   Lists and definitions of all codes used in the ECOTOX data fields and
reports. 

C Frequently Asked Questions (FAQ) Many questions can be answered by consulting
commonly asked questions. 

C Glossary   Definitions of acronyms and terms. 

C Other Ecotoxicology Sites  Helpful web sites related to ecotoxicology.

C Comments  If you have a question that can't be answered through this help system, 
please write us with your question.

SEARCH FORMS

Using Quick Search

This search form is limited to searches on habitat, kingdom, species, chemicals, effect
group and publication year.  The only output format available is the default browser
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viewable report (See Appendices C and D).  You may clear searches and perform the
search by clicking on the appropriate button at the bottom or top of the search form.  If your
sear ch requirements are more extensive, please go to the
Adv anced Search page.

Quick Search Button Bar

In the selection boxes for chemical and species, you must select an input category to the
right of each chemical and species entry.  

For information on Quick search strategy and how to search each field, go to Conducting a
Search section.  Within the Conducting a Search, you will find search strategies for
specifying a database, chemical searches, species searches and publication year
searches.  Some search strategies may only be used in the Advanced Search pages.  
 
Using Advanced Search

The Advanced search form is designed to lead you through a search session using
multiple forms.  Each page provides a menu bar, button bar and navigational hotlinks that
will take you to various locations within the ECOTOX search.  Within each search page,
the Menu bar options available are:

• Search Criteria (Specify Database, Chemical, Species, Test Conditions, Test
Results, Publications)

• Report Options (Report Content, View Current Search, Clear Current Search,
Perform Search)

• Tools (Browse Chemicals, Browse Species, Browse Effects, Other Ecotoxicology
Sites, ECOTOX Quick Search)

• Help (Overview, How to Search, Data Field Definitions, Code List, Search Planner,
Limitations, Glossary, FAQ Page, Contact Us)      

Advanced Search Button Bar
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Each search page will display the current search form you are viewing.  You may also
navigate around the search forms by using the “Go to:<search form name>” at the top right
hand corner of the page to move through the ECOTOX search pages.  By clicking on a
hotlink, you will move directly to the next search selection screen.

Go to: Chemical Criteria>> 

You may need to move within an ECOTOX search screen by using the scroll bars at the
right and bottom of the monitor. The right scroll bar moves up and down, the bottom moves
left and right.

Advanced Search Selection Boxes

Creating a search in the ECOTOX database requires that you enter information about the
chemicals and/or species that you are interested in as well as selecting other criteria (e.g.,
endpoints, effects, publication year etc.) from predefined lists.  The majority of these
selection boxes consist of two lists side-by-side, one containing items not selected and the
other containing those items that have been selected.  Positioned in between the lists are
two arrows, one pointing to the left and the other to the right, which are used to transfer
items between the lists.  To add an item to the list of selected items, click on an item, using
your mouse, in the list of items not selected and then click on the arrow that points to the
right in order to transfer it to the selected items list.  You should now see the item appear in
the selected items list.  Note that if the selected list already has many items in it, you may
have to use the scroll bar on the list to scroll down and see your selection.  Removing items
from the selected items list and returning them to the unselected items list is exactly the
same procedure only you select the item that you want to remove and use the left arrow to
move it back to the unselected items list.

Multiple Selection
Sometimes in the case of very long lists such as publication year, you may wish to select
multiple items from one list and move them to the other.  This can be accomplished in two
different ways, each useful for different situations.  The first 
method is useful when you wish to select multiple items from the list that are not necessarily
contiguous in the list.  For example, if you wish to search on publication years 1998, 1996
and 1970, you can hold the control key (ctrl) down on your keyboard while you click on each
item.  Each item that you click on, while the control key is held, will be highlighted and can
be transferred to the other list using the appropriate arrow button.  The second method is
useful when you wish to select a series of contiguous items in a list such as a range of
publication years.  For example, if you wish to search on all data from documents
published between 1994 and 1998, you first select 1994 with your mouse and then select
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1998 while holding the shift key down.  You will see that all years 1994-1998 are now
selected and you can move them to the opposite list using the appropriate arrow button. 

The publication year option also allows users to enter a range of data.  This option
appears directly below the Selection Boxes.  You should enter the bordering inclusive
years of your range in the “Starting Year” and “Ending Year” boxes (e.g., 1994 through
1998).

Moving Up/Moving Down within Selection Boxes
Some of the selection boxes which contain order dependent information, such as Output
Selections, may have two additional buttons on the right side marked Move Up and Move
Down  which can be used to change the order of the selected items list.  
For example, if you wish to make a field under the Using Output Selections screen appear
in a different position/column of your report, you should highlight the item in the list using
your mouse and then click either the Move up or Move Down  button.  You will see that it
moves within the list, yet the order of all other entries is preserved.  This feature is very
useful when you wish to customize your output or sort orders.  Note that multiple selection
using the control and shift keys does not apply to this feature, only one item may be moved
at a time.

CONDUCTING A SEARCH 

Search Strategy

The search forms are designed to search on all data, unless you restrict the search by
adding search criteria (e.g., clicking on clickboxes, enter text in an input field).  You may
perform the search at any time you have added all the search criteria you wish.  You do not
have to enter something in every search criteria area.  

The search strategy for ECOTOX includes two basic elements: combination/union and
intersection.  Within a search category (e.g., species), the search will combine all your
search selections.  Between each search field the search will intersect your selections. 
You may also want to use the ECOTOX Search Planner located in Appendix A to plan your
searches.   Appendix B describes some sample searches to assist you in learning the
ECOTOX software.     

Each Advanced search performed is divided into several search screens: specify
database, species, chemicals, test conditions (test location, exposure type, exposure
media, chemical analysis method), test results (calculated endpoint, observed effect,
documentation code) publication criteria (reference number and publication year).  These
search screens map to the navigational options (menu bar, button bar or Go to) available
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at the top of each search page.  Each search screen and each search element are
combined into a set that includes all the data records that contain information on the
search parameters for that search element.  For example, if you select the species fathead
minnow and Daphnia magna, the species result set will be the combination, or set union,
of the record numbers that contain information on those species.  If you also select the
Mortality Group Effect and Population Group Effect, the results of those two searches
would be combined into a single set of record numbers.  

Once all search elements are selected and the search is performed, the resulting sets of
database records are then intersected to determine which records they all have in
common and these are the records that are placed in the final report. 

Specify Databases

Habitat Type 
This allows you to select the ECOTOX database(s) from which to extract data in either
Quick or the Advanced search form.  The AQUIRE database is represented by the aquatic
habitat for both plant and animal kingdoms.  The PHYTOTOX data set is included in
terrestrial habitat and plant kingdom.  TERRETOX is selected by choosing terrestrial
habitat and the animal kingdom.  

To eliminate a currently selected habitat or kingdom or to select a database that is not
currently active, click the appropriate check box and the status of the selected database
will change.

Species Type/Kingdom
Species kingdom level searching is available on both the Quick and Advanced search
forms.  The plant kingdom search also includes species representing Monera and Fungi. 
Some test results report both plant and animal species as one effect measurement (e.g.,
aquatic community, plankton, soil community).  These results will be included when plant,
animal or both kingdoms are selected.  

Independently Compiled Data 
ECOTOX includes several independently compiled data sets.  Data sets from the
Organization for Economic Cooperation and Development (OECD), Russia, Office of
Pesticide Programs and MED-Duluth are included as subsets of the ECOTOX database. 
For further information on these data files, refer to the ECOTOX Data Field Definition
document. The default within ECOTOX is that all data sets are included in your search
result.  You may override the default and selectively search up to five specific data sets.  To
search on one or more independently compiled data sets, use your mouse button to select
one or more of the data sets.
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Evaluated Data Sets
ECOSSL (Ecological Soil Screening Level) and EVISTRA (EValuation and Interpretation
of Suitable Tests in AQUIRE) are not currently available options.  There are links the
additional background information located at the bottom of every search page.  Check the
“What’s New” on the ECOTOX web site for updates on availability.

Recent Modifications and Additions
You may search for data that has been modified or added to the system within the last
twelve months by selecting the number of months back that you wish to include in your
search.  The default is that all data, regardless of the date they were added to ECOTOX,
are included in your search result.  This feature permits searches for data that were added
or significantly modified through any of the months that you have selected.  To make a
choice, click the appropriate checkbox.  Clicking on another checkbox deselects the
previous selection. 

Chemical Searching

The Chemical criteria search screen allows several ways to search for chemicals using
CAS Registry numbers or Collective Index chemical names as well as options to search on
some pre-built lists of chemicals.  ECOTOX does not include a chemical synonym file,
therefore it is recommended that users search using the CAS registry number or chemical
lists.  The default is that all chemicals are selected for searching.

Using the Browse Chemical Utility
By clicking on the ‘Browse Chemical’ button under the Tools menu at the top of the search
screen (Advanced search) or to the left of the Chemical Selection box (Quick Search), a
new browser window will open and you will have access to the ECOTOX chemical
information index file.  This utility will assist you in planning your chemical search strategy
by allowing you to enter different chemical names or name sub-strings to determine
whether or not your chemical name is in the ECOTOX database and what other chemicals
will be included if your sub-string is used. The Browse Chemical search result provides a
list of the CAS Registry number(s) and all instances where your text string was included in
an ECOTOX chemical name.  For example, if you were to enter ‘xylene’ as a chemical
string within ECOTOX, the following chemicals would be included in your search result: 

81152 Trinitro-t-butyl xylene 
89587  Nitro-p-xylene 
881992  alpha,alpha'-Hexachloro-m-xylene 
1074244 2,5-Dibromoxylene 
1330207 Xylene 
13209159 a,a,a',a'-Tetrabromo-O-xylene 
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You can then either use the resulting chemical names in your search or conduct your
search using the CAS Registry numbers that are displayed using the Browse Chemicals
utility, under Tool menu bar.   Remember that you can cut and paste from this screen into
the ECOTOX search screen.

To conduct a search on a particular chemical you must identify the compound one of three ways:
 
CAS Number - Enter the CAS numbers you wish to search on, placing each number in a
separate field in the CAS Numbers section.  You may enter the CAS number with or
without hyphens and leading zeros.

Chemical Name - Enter the names of the chemicals you wish to search on, placing each
name in a separate field.  After entering the chemical name identify whether you wish to
search on the exact name (Chemical Name (exact)) or searching on a substring (Chemical
Name).  If Chemical Name is selected from the Choose Category list, any  chemical
names including the text string(s) entered will be included in your search results.  For the
most part, ECOTOX uses the Collective Index name for chemical searching and does not
currently have a synonym file.  If you want to restrict the search to only search on a specific
term, you may choose the exact match category.  For example, if you enter the term
benzene selecting the exact match category, you will only search for the specific chemical
benzene, not all the benzene derivatives.  It is recommended that users search on CAS
numbers, if they are unsure of the Collective Index name.

Select from Chemical Lists - This option is only available in the Advanced Search option. 
Chemical lists have been provided to effectively search chemicals important to the U.S.
EPA, other Federal agencies and regional and state offices.  Lists include U.S. EPA
priority lists, lists of regional concern, metal compounds, and organic compounds. 
Individual components of the lists are available by clicking on View the Chemical List
above the Chemical List selection box. .  See the section on “Using Selection Boxes” if you
need help selecting a chemical list or lists.  

Example Chemical Selection Strategies
By clicking on the ‘Chemical’ button at the top of the Advanced search page, you will move
to the Chemical Search screen.  The following examples will provide some guidance when
conducting a chemical search.

• In the case of metal compounds, it may be easier to search by chemical name. 
Suppose you want to search for copper compounds. Entering cupr and copper as
chemical names will find copper and several copper compounds with fewer keystrokes
than typing all the individual CAS Registry numbers. You may also search a group of
copper compounds using the ECOTOX chemical list feature.
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• In some cases, organic compounds may be searched by chemical name. Suppose you
want to search on all dioxin compounds. Entering dioxin as a chemical name will be
more efficient than entering all the specific dioxin chemical names or CAS numbers. 
Remember, though, entering some chemical names may identify many non-applicable
chemicals (e.g., benzene will result in all compounds with the sub-string benzene in the
chemical name).  You may want to use the Collective Index (exact) search category for
very specific names (e.g., benzene, xylene) when you do not want all the chemical
derivatives.

• For pesticides, most synonym names are not in the Browse Chemical index file and
using the CAS Registry number is the only method to search ECOTOX.  Chemical
CAS Registry numbers may be located in chemical company catalogs or other
chemical indexing resources.  For example, searching chemicals by the common
name, such as lindane, diazinon, atrazine or malathion will not locate any records in
ECOTOX unless you locate the CAS Registry number for each and then perform a
CAS number search.  If you are unsure of a CAS Registry number or chemical name,
you may interactively use the Browse Chemicals index to search on chemical names or
fragments of names.

Species Searching

The default within ECOTOX is that all species are selected for searching.  To conduct a
search on a particular species you must identify the organism one of four ways: kingdom,
species number, Scientific name or common species name.  Although it is faster and
more efficient to search by species number this may not always be a realistic option, in
which case, searching by Scientific name and common name may be necessary.  See the
examples below for further explanation.

Using the Browse Species Names
By clicking on the ‘Browse Species’ option to the left of the Species Selection search box
(Quick Search) or under the Tools menu at the top of the search screen (Advanced
Search), a new browser window will open and you will have access to the ECOTOX
species information file.  This utility will assist you in planning your species search strategy
by allowing you to enter different Scientific and common species names or name sub-
strings to determine whether or not your species is in the ECOTOX database and what
other species will be included if your sub-string is used.  For example, by entering the
species Scientific name ‘Ceriodaphnia reticulata’ the following species numbers and
Scientific names will be included in your search results:

963 Ceriodaphnia reticulata 
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2371 Ceriodaphnia dubia - Ceriodaphnia reticulata dubia (Historical Name)

You can then use the names provided in the output to perform your searches, or use the
species numbers listed by each name. 

Scientific name: All data records within ECOTOX include a scientific name for the test
species.  All names have been verified in reliable taxonomic sources.  You can conduct an
exact search on the scientific name (Scientific name (exact)) or search on fragments of
scientific names, genus, or species names (Scientific name) by selecting the proper
search option from the 'choose category' list.  ECOTOX includes links to scientific name
synonyms, therefore searches will retrieve all records associated with the selected
scientific name including old taxonomic terminology. 

Common name: All data records within ECOTOX include a common name for each
species.    You can conduct an exact search on the common name (Scientific name
(exact)) or search on fragments of common names (Scientific name) by selecting the
proper search option from the 'choose category' list.  

Species Number: All species in the ECOTOX database have been assigned a unique
number.  Numbers can be located by using the 'Browse Species' option.

Example Species Searches
By clicking on the ‘Species’ on the button bar at the top of the search page, you will move
to the Species Search screen.  The following examples will provide some guidance when
conducting a species search.

Scientific Name Searches 

• Entering Pimephales promelas in the Scientific name search will result in
only data for fathead minnows. If you consistently use a limited number of
species names, you may want to use the species number for searching as it
results in faster more efficient searches.

• Using the genus name may be helpful when interested in a broader search.
Entering daphnia in the Scientific name search will result in all Daphnia and
Ceriodaphnia species.

• You may also enter a historical Scientific name and still retrieve data for a
species. For example, if you enter Salmo gairdneri and retrieve the data, the
output will display the currently accepted name, Oncorhynchus mykiss.
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Common Name Searches

• Common names may be efficient, if there is a unique common name for that
organism. Entering mallard in the common name field will result in only
mallard duck results. 

• Entering the term duck will output results for duck and duckweed.  In this
case, searching using the common name (exact) or selecting only on the
terrestrial habitat will eliminate the duckweed from the search.  

• Entering bird in the common name field will result in bird and ladybird beetle
data.  In addition, using the term bird will not ensure that all bird data in the
system will be extracted because the species name may not use the term
bird in the common name. 

Species Number Searches

• The species number is the unique indexing number assigned to each
species in ECOTOX and is the most computationally efficient method of
searching for species data.  Use of species number may be useful if you
consistently search on the same set of species.  The best way to determine
species numbers is to use the Browse Species search utility.

Test Conditions

The options for searching by test conditions are briefly described below. These options
are only available in the Advanced Search option.  For additional information about these
fields, please refer to the ECOTOX Data Field Definition document.  Many of the test
conditions require the use of selection boxes on the search form, for help in using these
see “Using Selection Boxes.”
 
Test Location
The valid entries for test location are Lab (laboratory), Field (all outdoor field tests,
artificial, natural or undeterminable) and Not Reported (i.e., the author(s) did not present
sufficient information to determine test location).  The default within ECOTOX is that all
data, regardless of test location, are included in your search result.  You may override the
default and selectively search up to five specific test locations.  To selectively search on a
specific test location, use your mouse button to mark the appropriate checkbox.

Media Type 
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The default within ECOTOX is that all data, regardless of test media, are included in your
search result.  To selectively search on a specific exposure type, use your mouse button to
mark the appropriate checkbox.

Aquatic freshwater tests include those conducted in freshwater, reconstituted water,
distilled water, or tap water.  Saltwater tests include those conducted in natural or artificial
seawater, brackish water, or estuarine water.  Not Report (NR) is used if a determination
cannot be made regarding the use of either freshwater or saltwater.  

Terrestrial exposure media selections are focused on tests using a substrate (e.g., soil or
artificial media).  If the terrestrial organism habitat does not utilize a substrate for nutrition
(e.g., birds, mammals), do not select any exposure media types.

Exposure Type
You can select the exposure type by clicking the items in the menu box.  Organisms are
typically exposed to toxicants through aqueous, diet, injection, inhalation, topical or
environmental routes.   Occasionally, an exposure may be through multiple routes (e.g.,
such as topical and oral).

ECOTOX includes chemical exposures on whole living organisms.  In vitro assays are not
included.  The terrestrial plant database contains some studies using excised organs and
cell cultures from plants, however these types of studies are not actively coded at this time. 

Chemical Analysis Method 
Select the appropriate checkbox using the following options:

Measured  -  Exposure and/or observation concentrations or doses are
quantitative; analysis  methods may be reported; note that exposure concentrations
may be analyzed but observations could be reported in terms of nominal,
unmeasured values. This distinction must be noted when coding.

   
Unmeasured - Exposure and/or observation concentrations or doses are clearly
identified as nominal values; or when the author does not report any information
whether the concentrations were measured or nominal, I.e., unmeasured is used as
a default value when there is no information provided about the chemical
concentrations.

   
Not Reported -  Exposure and/or observation concentrations or doses are reported
as both the measured and the unmeasured values but it is not clear whether
observation/response dose is a measured or nominal value.
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Test Results

Endpoint
For the purposes of the ECOTOX database, an endpoint (e.g., LC50) is defined as "the
quantification of an observed effect obtained through statistics or other means of
calculation for the express purpose of comparing equivalent effects."  The default is that all
endpoints are selected for searching.  To conduct a search on a particular endpoint you
must go to the Endpoint search section (Advanced Search) and move the desired
endpoint(s) to the Endpoint Selected box.  

The bottom of the Endpoints Selection box has a checkbox 'Report Endpoints Only'
Selecting the “Endpoints Only” option restricts the output to include only those test records
that have an associated endpoint.
 
Effect 
The default is that all effects are selected for searching.  To conduct a search on a
particular effect you must go to the Effect search and check on the desired effect(s).  Use
Browse Effects to locate Effect Groups and associated effect measurements.  The
Advanced Search Effect menu allows you to search by Effect Groups, Effects and
Measurements. 

Effect Group:  The ECOTOX database categorizes all observed effects under at least one
of ten major effect group codes (accumulation, behavior, biochemical, growth, histology,
mortality, physiology, population, reproduction, and ecosystem). You may select all effects
associated with a major effect grouping by clicking the box to the left of the appropriate
major effect group.  For example, by selecting Mortality from the menu will retrieve all data
from all selected databases with effect codes categorized as mortality effects.  

Effect: (Advanced Search only) For the purposes of the ECOTOX database, a
toxicological effect (e.g., mortality) is defined as "the observation of a response resulting
from the action of a chemical stressor."  The ECOTOX Code List provides definitions of
each effect code used in ECOTOX. 

Effect Measurement: (Advanced Search only) For further refinement, you may click on the
Effect Measurement Search button within the Effect Search menu to open a window listing
specific measurements for each effect group you selected.  Measurements include
quantitative observations that describe and evaluate biological responses to toxicants. 
Each effect (e.g., Growth) can have several associated measurements (e.g., length,
weight).  

Recovery Results
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Within the Effects menu (Advanced Search) the ‘Include Recovery Results’ option allows
you to include in your search results responses observed during a post exposure period.
This is only available for aquatic test results.   If this option is not selected, your ECOTOX
search results will only include effects observed during the direct exposure period of the
study.  The Recovery Results are included by clicking on the checkbox.  Recovery results
are indicated in the aquatic report by the placement of a tilde(~) character before the effect
code (e.g., ~MOR).

Documentation Code
The ECOTOX documentation codes indicate the completeness of methods documentation
and results presentation accompanying the data. Documentation code assignments range
from Complete (C) to Moderate (M) to Incomplete (I). The default within ECOTOX is that all
data, regardless of documentation code, are included in your search result.  You may
override the default and selectively search up to two specific documentation codes.  To
selectively search on a specific documentation code in the Advanced Search, click to
mark the appropriate checkbox.

Publications

Reference Number 
Each publication abstracted for the ECOTOX database effort is assigned a unique
reference number.  These reference numbers appear in all default ECOTOX outputs.  You
may conduct searches on specific reference numbers for aquatic and terrestrial habitats.  If
no entries appear in the boxes, the default is that all reference numbers are included in
your search strategy.  To selectively search on a specific reference number, enter the
specific reference/publication numbers in the boxes provided. This option is only available
in the Advanced Search page.

Publication Year
The aquatic component of ECOTOX contains data from publication years 1915 through
2000; the terrestrial plant component of ECOTOX contains data from publication years
1926 through 2000; terrestrial animal component of ECOTOX contains data from
publication years 1969 through 2000.  The default within ECOTOX is that all data,
regardless of publication year, are included in your search result.  You may override the
default search by either selecting years from the ‘Publication Years Available’ box and
moving them to the ‘Selected Box’, or by entering a range of years in the ‘Starting Year’
and ‘Ending Year’ boxes.  

SORT ORDER
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The data are sorted within the aquatic and terrestrial reports in a predefined way.  Sort
order modifications are not available within the ECOTOX software.  If you require a more
specific sort, download your search in a delimited file format (under Report Content) and
upload the file into a spreadsheet or database on your PC.  Use the spreadsheet or
database software to sort your data.

For the aquatic test result outputs, the default sort order is Test Location, Level of
Calculated Results Reported, CAS Registry number, Species Scientific name, Endpoint,
Effect, and Exposure Duration.  Due to the default Level of Calculated Results sort, data
with calculated endpoints, will be presented first, followed by data with statistical analysis
or percent (%) effects reported and finishing with ranged data or observed effect results
that were not analyzed further by the authors.  The Test Locations sort separates the report
into records not reporting a test location, Laboratory studies and Outdoor Field results. 

The  terrestrial report is sorted into multiple pages by Chemical Name, Species Scientific
Name, Publication Year, and Reference Number fields.  Remember, the Sort Order does
not change the data, it just changes the ORDER in which the data appear in the report. 
 

REPORT CONTENT

Report content modifications are only available in the Advanced Search page. This section
allows you to change the output fields as they appear in the report. The individual default
fields vary for each database. Output field selections are set at a default which will print the
data in a table format with headings. The report width is defined by the data fields and the
Web browser settings selected, so carefully modify the output fields to fit within your
preferences.

To obtain full citations for a delimited file, you need to  repeat the search selecting the
Browser Viewable Report performing the same search.  After the report displays, click on
the References link in the output, then view or save the full citations.

Report Format: Above each output selections box, is a checkbox that allows the user to
modify the format of the report output.  The default option is a web browser display of the
data, but a delimited file format is also available.  Each data field in the delimited file
format is separated by the '|' character (usually located on the \ key).  Delimited ASCII files
can be saved to your hard drive and uploaded into your local spreadsheet or database. 

Aquatic Report
The aquatic default output fields for test records reporting a test location as 'not reported'
or laboratory are Test Location, CAS Registry Number/Chemical Name, Scientific
Name/Common Name, Endpoint, Effect, Trend/Effect %, Water Type, Duration/Exposure
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Type, Concentration Type/Value, Significance/Level, and Tissue/BCF, Reference Number
and Reference Citation.  See Appendix C for a sample of the aquatic default report. 

For outdoor field exposures, the aquatic default output fields are Test Location, CAS
Registry Number/Chemical Name, Scientific Name/Common Name, Endpoint, Effect,
Trend/Effect %, Exposure Type, Duration/Exposure Type, Concentration/Application Rate,
Application Type, Application Frequency/Date, Significance/Level, Site/BCF, Reference
Number and Reference Citation.

Note that inclusion of the Reference Citations field will add a separate section to the end of
the report, which contains a bibliography of all the references associated with the reported
data records.  Reference Citations, even if selected, will not appear in the  delimited data
format files, only the reference number will appear in the report.
.
Terrestrial Report
The default terrestrial report includes most available terrestrial fields.  You may only modify
the output fields in the delimited file report format.  You may need to reformat your web
browser software to landscape format or modify your font when you print a hard copy of
your report.  View Appendix B to view the terrestrial report default fields and Appendix D
for a sample terrestrial default report.

PERFORM SEARCH

View Current Search

Before submitting your entries you may want to review them by clicking the View Current
Search from the Report Options menu, Review Selections button or navigate back through
the search form(s) in your Advanced search.  Finally, before submitting your search
strategy for retrieval, be sure you have selected the Report Content and Format you
desire.  For documentation purposes, you may print the View Current Search information
and attach it to the reports that are generated using that criteria.

Output Selection

Two output formats are available; browser viewable report and exporting a delimited data
file. The default is set to interactively view the output in the report format. Upon submission
of the search, a separate browser window will be opened where your search results will be
displayed. 

Browser Viewable Report
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This option will display the formatted/tabular report in a separate browser window after the
search has completed.  The report may then be viewed, printed or saved to a file using the
File menu option on your browser.  Your first page of data records are always displayed
below the report header information. 

You can move through the report in a number of ways.  To view a page from the report,
scroll through it by using the scroll bar on the right side of the window.  The output window
will provide hotlinks to each page of the report. The output window will also provide hotlinks
to the first pages of the laboratory, outdoor field and reference sections of the report. 
String searches may also be performed by clicking the Web browser Edit menu on the top
window Tool bar and using the Find In Page option.  Note that the size of the report window
can be increased or decreased in size at any time. 

To print a report, select the browser File menu and select the Print option. To save the
report as a file, use this same File menu and choose the Save As option.  It should be
noted that each page identified in the browser window may actually contain several
printable pages (i.e., page 1 when printed may result in 18 printed pages), and that the
user must click each page identified in the browser window in order to view, print or save
all downloaded records.   

The ECOTOX software cannot control your web browser print function and field width.
Successfully printing output is dependent upon your web browser preferences and/or your
printer capabilities.  These options can help to fit your report on a printout:
 
C Reduce your web browser font size.
C If your report width is wider than a portrait page size, you can modify your web

browser print option to a landscape orientation 
C Some web browsers have a Print Preview option to see how your output will print

out.  
C You may want to consider using the delimited file option, then merging/adjusting the

columns or selecting fewer output fields. 
C If you are using Internet Explorer, choose View->Fonts->Smallest from the menus

and then print in landscape mode.  This will work for very wide reports.  Note that
Netscape allows you to reduce the font size as well, but when it prints it reverts to
the original font size and truncates the right side of the report. 

C Some printers have advanced settings available from the print window that allow
you to "scale" the print image.  If this feature is available try different values to
determine which one works best for your reports. 

C Save the browser report as a ".htm" file and open it with a word processing
application where the font size can be reduced and columns sizes adjusted. 
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The data file will contain data representing the specific Search Criteria and Report Options
you have selected.  Each report will include contact information for the Scientific Outreach
Program, date of the search, number of records in the report and number of separate
browser window pages.

Generate the Entire Report
Generate the entire report on a single viewable/printable page.  This option is generally
used when you what to electronically save the entire data report. Reference citations are
viewed/saved as a separate page. Large reports may overload your browser causing
instability in your browser or computer.

Delimited Report
When you retrieve the results of your search in a delimited format a message box will
appear on your screen.  Select 'Save file.'  A 'save as' window will appear.  Select the
appropriate directory on your hard drive.  You may change the file name as this time. 
Although *.tsv stands for Tab Separated Values, the report is actually a vertical bar (|)
delimited file. A help window for using the delimited file will automatically open when you
are saving a delimited file from ECOTOX.  You may wish to print this out for later use when
importing the data into a spreadsheet/database.

Each field will be separated by a vertical bar ("|") and each record will appear on a
separate line.  Using the vertical bar as a delimiter between fields is typically not the
default method supported by applications that import data (e.g., spreadsheets) and hence
you may have to specify the vertical bar as the delimiter when you import the data.  The
vertical bar key is usually found on the same key as the "\" (backslash) character on most
keyboards and may appear as two shorter vertical lines with a gap between them. 

To obtain full citations for a delimited file, you need to repeat the search selecting the
Browser Viewable Report performing the same search.  After the report displays, click on
the References link in the output, then view or save the full citations. 

To import this file into a Microsoft Excel spreadsheet, you can do the following steps: 

1. Start the Spreadsheet 
2. Go to the menu choice File->Open 
3. Change the file types to "All file types (*.*)"
4. Select the file 
5. Choose a delimited file format
6. Choose a vertical bar (|) as the field delimiter 
7. Click Finish 

Your file should now be imported into the spreadsheet for your analysis. 
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Perform Search

Click the Perform Search button when you are ready to initiate your search strategy and
report/output creation.  While the system is performing the ECOTOX database search, a
separate window is created indicating that an ECOTOX database search is taking place. 
When the search is complete, the appropriate results (report contents or data file name) for
aquatic and/or terrestrial report(s) will appear in this separate window.  

As the search is being conducted, the system will display the number of records located for
aquatic and/or terrestrial species.  If the number of records is larger than you would like to
view, you may click the 'Stop Search' button at the top of the search window and return to
the search window and refine your search strategy.  If you have selected the default outputs
format (web browser view screen) the number of data records that can be included in the
reports are 5000 for aquatic data and 500 for terrestrial data.  The delimited export file will
retrieve up to 10,000 terrestrial or aquatic records.

Once each report is completed, the banner at the top of the window will become visible
with the words 'the aquatic /  terrestrial report is ready.’  Click on either the aquatic or
terrestrial header to view the respective reports.  Depending on the report format you
selected under 'Report Content', your prompt in the search window will differ.  

The number of hits you retrieve is based on test records and not references.  Your output
may span several pages with multiple test records within each page.  The reference
citations for your entire search will be located on the last page of your report.

Clear Search

Once you have completed your search, and closed the search window, you will be returned
to the original search window.  The search strategy will remain intact, so you may go back
and refine your search if you wish.  If you want to conduct another search, you may clear the
search by either clicking the 'Clear Search' button at the top of the search window, or
selecting 'Clear Search' from the Report Options under the Advanced Search screen.
Clearing the search will return all search options to their original default values.

OTHER ECOTOXICOLOGY SITES
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Under the Help Overview and the Tools menu bar in the Advanced Search, is an option to
look at other ecotoxicology sites on the World Wide Web. Providing links to these sites
does not imply endorsement by the U.S. EPA.

EXIT FROM ECOTOX

Exiting your Web browser or visiting another Web site will leave the program. Exiting the
Web browser will save the last search strategy you set up prior to leaving for seven days, if
your browser is configured to accept Cookies.
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APPENDIX A:  ECOTOX SEARCH PLANNING FORM

Use this form to simplify the planning of your searches or to document searches for others
to perform. 

Search Options
Habitat(s):                     AQUATIC _____  TERRESTRIAL ____
Taxonomic Group(s):  ANIMALS ____    PLANTS ____

Chemical(s):  
CAS Numbers:        ___________________________________________________
Chemical Names:     ___________________________________________________
Chemical List:          ___________________________________________________

Species: 
Species Numbers:  ____________________________________________________
Scientific Names:         _________________________________________________
Common Names:  _____________________________________________________
 
Endpoint(s): __________________________________________________________ 
 
Effect Group(s): 
___ Accumulation                ___ Mortality
___ Behavior                        ___ Physiology
___ Biochemical                  ___ Population
___ Cellular                         ___ Reproduction
___ Growth                          ___ Ecosystem

Additional Effects and Measurements___________________________________________________
Recovery Results: ___ Include Recovery Results for aquatic data
 
Test Location(s): 
___ Lab        ____  All Field  Tests
                      ___   Field Artificial
                     ____  Field Natural
                     ____  Field Undeterminable

Exposure Media(s): 
WATER:    ___ Freshwater  ___ Saltwater  __ Unknown
SOIL:         ___ Artificial   __ Humus __ Litter __ Manure __ Mineral Soil __ Mixture  __ Natural Soil 

     ___Unspecified Soil
ARTIFICIAL:  __ Hydroponic __ Other  __ No Substrate

Exposure Type(s): 
__ Diet                                           ___ Flow-through (aquatic)
__ Injection                                    ___ Leaching (aquatic) 
__ Topical                                      ___ Intermittent (aquatic)
__ Environmental (terrestrial)       ___ Renewal (aquatic)
__ Inhalation  (terrestrial)              ___ Static (aquatic)
__ Multiple Entry (terrestrial)        ___ Tidal (outdoor aquatic) 
                                                      ___ Lentic (outdoor aquatic)  
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                                                      ___ Lotic  (outdoor aquatic) 

Chemical Analysis Method: 
___  Measured    ___ Unmeasured    __ Not Reported
 
Documentation Code(s): 
___ Complete  ___ Moderately Complete __ Incomplete

Publication Year(s): ________________ 

Reference Number(s):  
Aquatic: ___________________________
Terrestrial:  _________________________

Report Options 

Output Format: 

___ Browser Viewable Report - Multiple viewable pages 
___ Browser Viewable Report - Single viewable/printable page 
___ Delimited Report - used for importing into other software applications (e.g. Excel, Lotus etc.)

Modifications to Output:  Standard default output elements are listed in bold..  Some aquatic output
options are available for Field Data only, and are indicated by (Field Data Only).  Modifications to report
options are only available in the Advanced Search. 

Aquatic  Output Elements  (default report
items are in bold)

Terrestrial Output Elements (default for browser
viewable or delimited are in bold) (modify for 

delimited output only)

___ Test Location 
___ CAS Number/Chemical Name 
___ Scientific Name/Common Name 
___ Endpoint 
___ Effect 
___ Trend 
___ Exposure Type 
___ Exposure Duration 
___  Media Type 
___ Concentration Type 
___ Concentration/Application Rate (Field Data only) 
___ Application Type (Field Data Only) 
___ Application Frequency (Field Data Only) 
___ Application Season/Date (Field Data Only) 
___ Significance/ Level 
___ Response Site 
___ Reference Number 
___ Application Rate (Field Data Only) 
___ Alkalinity 
___ BCF Value  
___ Chemical Analysis Method 
___ Chemical Comments 

___ Author
___ Application Frequency
___ Bases of measurement (wet/dry)
___ CAS Number 
___ Chemical Analysis Method
___ Chemical Name 
___ Chemical Comment
___ Chemical Formulation
___ Chemical Grade
___ Chemical Purity
___ Concentration/Dose
___ Control Type
___ Documentation Code 
___ Dose Number 
___ Dose Statistical Method
___ Effect 
___ Effect Measurement
___ Endpoint 
___ Exposure Dose 
___ Exposure Duration 
___ Exposure Number 
___ Exposure Comment
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___ Control Type
___ Documentation Code 
___ Effect Percent  
___ EE Comment 
___ Experimental Design 
___ GEO Code (Field Data Only) 
___ Geographic Location (Field Data Only) 
___ Habitat Code 
___ Habitat Description (Field Data Only)
 ___ Hardness
 ___Test Number 
___ Longitude/Latitude (Field Data Only) 
___ Organic Carbon 
___ Organic Carbon Type 
___ Organism Comments
___ pH 
___ Publication Year 
___ Reference Citation 
___ Salinity
 ___Species Number 
___ Study Type 
___ Substrate Code (Field Data Only) 
___ Temperature

___ Exposure Type 
___ Gender
___ Ionic Fraction
___ Lifestage 
___ Media Type 
___ Observation Duration 
___ Observed Response 
___ Organism Age
___ Organism Comments
___ Organism Source
___ Publication Year 
___ Reference Citation 
___ Reference Number
___ Response Site
___ Result Comment
___ Result Percent Lipid 
___ Result Percent Dry/Wet Weight
___ Result Record Number
___ Result Statistical Method
___ Reviewer Assigned Endpoint
___ Sample Number 
___ Significance/ Level 
___ Soil Cation Exchange Capacity
___ Soil Concentration Measured
___ Soil Moisture
___ Soil Organic Matter
___ Soil pH 
___ Soil Clay %
___ Soil Sand %
___ Soil Silt %
___ Species Common Name 
___ Species Scientific Name
___ Species Number 
___ Study Duration 
___ Test Comments
___ Test Location 
___ Test Number
___ Title
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APPENDIX B:  EXAMPLE SEARCHES

Use this form to simplify the planning of your searches or to document searches for others
to perform.  After each example search, remember to click on “Clear Search” before
proceeding to the next search.  These examples are for you to try in the Advanced Search
pages.

Example A  

You want to locate all reproductive effects data for mercury compounds. What types of
reproductive effects were measured ?

1. Click on Chemical button bar. Scroll down to Chemical List. Select MERCURY from the
metals list, then click on right arrow graphic to move “Mercury” to the selected list.
2. Click on tool bar Test Results Criteria button. Scroll to Effects list.  Click on Group Effect 
REPRODUCTION.  This will display and select all the reproductive effects within
ECOTOX.
3. For Aquatic data, click on button bar Report Content button. Select EE COMMENT from
the Aquatic laboratory and field selection lists, then click on right arrow graphic to move
“EE Comment” to the selected list.  The Terrestrial data report the specific measurement in
the default report.
4. Click on “Perform Search”

Example B

You want to locate LC50 data on freshwater organisms exposed to malathion.
  
1. Click Specify Database on the button bar.  Select AQUATIC habitat checkbox.
2. Click Chemical on the button bar. Type in CAS Number: 121755. 
3. Click Test Results on the button bar.  In the Endpoint menu, select LC50 from the list,
then click on right arrow graphic to move “LC50 ” to the selected list.
4. Click Test Conditions on the button bar.  Scroll down to the Exposure Media menu and
click on FRESHWATER checkbox.
5. Click on “Perform Search” button.

Example C

You want to locate recently published, well documented lethality endpoint only studies
on Daphnia magna.

1. Click Specify Database on the button bar.  Select AQUATIC habitat checkbox. 
2. Click Species Criteria on the button bar. Type in DAPHNIA MAGNA and select the
Scientific name category. 
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3. Click on tool bar Test Variables button. In the Endpoint menu, select the REPORT
ENDPOINTS ONLY checkbox. 
4. Scroll down to the Effects menu and click on the MORTALITY Effect Group  checkbox.
5. Scroll down to the Documentation Code menu and click on the checkbox for
COMPLETE to obtain all well documented publications. 
6. Click on tool bar Publication Criteria on the button bar.  Scroll down to publication year
search.  Select 1998, 1997, 1996, 1995, 1994 from the list, then click on right arrow
graphic to move them to the selected list.  Another method of searching multiple
publication years is to  type in the range of years (1994 to 1998) at the bottom of this
menu.
7. Click on “Perform Search” button.

Example D

You want to locate toxicity data for frog tests performed in an outdoor location. You would
like to move these data records into your own database.

1. Click Species on the button bar. Enter 'Frog' in the species selection box, and select
'Common Name' from the 'Choose Category' list. Note:  If you only want larval aquatic
lifestage, specify the aquatic habitat; adult terrestrial lifestage specify the terrestrial
lifestage.
2. Click Test Conditions on the button bar.  In the Test Location menu, select the checkbox
ALL FIELD TESTS from the list.
3. Click Report Content on the button bar. Scroll down and click on the DELIMITED
REPORT option. 
4. Click on “Perform Search” button.

Example E

You want to use the SARA Title III Toxic Emissions Inventory chemical list and locate
data that are in the EPA Fathead Minnow Database.

1. Click on Specify Database button. Select the FATHEAD MINNOW DATABASE
checkbox within the Independently Compiled Database selection box. 
2. Go to the Chemical search screen. Scroll down to Chemical List.  Select SARA TITLE
III TOXIC EMISSIONS INVENTORY from the list, then click on right arrow graphic to
move it  to the selected list.
3. Click on “Perform Search” button.
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APPENDIX C: AQUATIC REPORT FORMAT

ECOTOX: Ecotoxicology Database
U.S. Environmental Protection Agency
Office of Research and Development

National Health and Environmental Effects Research Laboratory
Mid-Continent Ecology Division

Contact: Scientific Outreach Program
218-529-5225 or FAX 218-529-5003
E-mail: ecotox.support@epa.gov

Researchers and managers using ECOTOX data for analysis or summary projects should consult with the original scientific paper to
ensure an understanding of the content of the data retrieved from ECOTOX

Report Generated: Wed Dec 2 14:12:02 1999 

Records found: 1
1   2   NEXT > > 

Laboratory Data   References

 Page 1 of 2  
Scientific name,
Common name

Endpoint Effect
Group

Water Type
Dur (days) 
 Exp Typ

Conc (ug/L) Signif  
 Level

Tissue
 BCF

Ref # 

Test Loc: LAB 

CAS #/Chemical: 8001352, Toxaphene 
Pimephales promelas 
Fathead minnow NR-LETH MOR FW

1.00 
S

A 10   4777 

Scientific name,
Common name

Endpoint Effect
Trend
 Effect %

Water
Type

Dur (days)
 Exp Typ

Conc (ug/L)
  Appl Rate

Appl
Type

Appl Freq
Date/Season

Signif 
 Level

Tissue 
 BCF

Ref # 

Test Loc: FIELDN 

CAS #/Chemical: 298000, Phosphorothioic acid, O,O-Dimethyl-O-(p-nitrophenyl)ester  

Bufo marinus
Giant toad

 MOR
INC 
 63

FW
0.007 - 0.08
 O

A 280 
0.32 AI kg/ha

AS 1X 
 

 17983

Tilapia mossambica
Mozambique tilapia

NR-ZERO MOR
NEF
 0

FW
0.007 - 2.00
 O

A 2.3 - 280 
 

AS 2X 
 

 17983

APPENDIX D:  TERRESTRIAL REPORT FORMAT
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ECOTOX: Ecotoxicology Database

U.S. Environmental Protection Agency

Office of Research and Development
National Health and Environmental Effects Research Laboratory

Mid-Continent Ecology Division

Contact: Scientific Outreach Program
218-529-5225 or FAX 218-529-5003
E-mail: ecotox.support@epa.gov

Researchers and managers using ECOTOX data for analysis or summary 
projects should consult with the original scientific paper to ensure an 

understanding of the content of the data retrieved from ECOTOX

Report Generated: Mon Feb 7 11:31:39 2000 

                           Terrestrial records found:   4           Page 1 of 2

1   2   Next >>

References 

NR = Not Reported

A study of 12 week(s) duration using Natural soil media was conducted in a Laboratory, indoor site location with NR obtained Lumbricus
rubellus (Earthworm). The adult (age: NR and organism characteristics of: ~700 mg) were exposed for a duration of 12 week(s) to a NR
application of Cadmium chloride (CAS #: 10108642) in NR carrier or a(n) NR positive control through a(n) direct application exposure route. The
reported chemical concentrations are the result of Measured analysis of chemical solutions and are based on the NR ion. The Natural soil was
comprised of NR sand, NR silt, and NR clay, pH 7.3, and 8 % Organic Matter , 35% - 40% moisture and NR CEC. The concentrations are based on
DRY soil weight and are the result of unmeasured analysis of the chemical concentration in soil. (Reference 6015, Ma, 1982, Test Number 4082).

Effect of Cadmium chloride on Lumbricus rubellus Mortality 

Measurement Response
Site

Observation
Duration

Concentration / Dose 
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0.5
mg/k
g soil

20
mg/kg soil

150
mg/kg soil

1000
mg/kg soil

3000
mg/kg soil 

ENDPOINT: 6 week(s) LC50 of mg/kg soil (NR: 150 - 1000) on Measurement: Mortality; Response Site: NR 

Mortality Not Reported 6 week(s) 
4
%

0
%

3
%

100
%

100
% 

Mortality Not Reported 6 week(s) - - 3
%

100
%

100
% 

Mortality Not Reported 12 week(s) 12
%

12
%

- - - 

A study of 17 day(s) duration using Artificial soil media was conducted in a Laboratory, indoor site location with NR obtained Avena sativa
(Common oat). The seed organisms (age: 0 day(s) and organism characteristics of: NR) were exposed for a duration of 17 day(s) to a Dosed 1
time(s) per study period application of Cadmium chloride in NR carrier or a(n) NR positive control through a(n) direct application exposure route.
The reported chemical concentrations are the result of Unmeasured analysis of chemical solutions and are based on the CD ion. The Artificial soil
was comprised of 90.5% sand, 5.8% silt, and NR clay, pH 5.1, and 3.7 % Organic Matter , 80 moisture and NR CEC. The concentrations are based
on DRY soil weight and are the result of unmeasured analysis of the chemical concentration in soil. (Reference 6169, Adema, 1989, Test Number 5160).

Effect of Cadmium chloride on Avena sativa Growth 

Endpoint Data Only 

ENDPOINT: 17 day(s) EC50/ of 305 mg/l (NR: NR) on Measurement: Biomass;
  Response Site: Aboveground portion 

ENDPOINT: 17 day(s) NOEC of 10 mg/kg soil (NR: NR) on Measurement: Biomass;
  Response Site: Aboveground portion 

ENDPOINT: 17 day(s) EC50 of 97 mg/kg soil (NR: NR) on Measurement: Biomass;
  Response Site: Aboveground portion 
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TERRESTRIAL DEFAULT OUTPUT FIELD IDENTIFIERS

Bold and underline is the field name.

A study of STUDY DURATION MEAN (MIN-MAX) UNIT  duration using EXPOSURE MEDIA media was conducted in a TEST LOCATION site location with ORGANISM
SOURCE (if NR appears in this field it should be out put) obtained SCIENTIFIC NAME. The LIFESTAGE organisms (age: ORGANISM AGE AGE UNIT and organism
characteristics of: ORGANISM COMMENTS) were exposed for a duration of EXPOSURE DURATION MEAN (MIN-MAX) UNIT  to a APPLICATION FREQUENCY application
of CHEMICAL NAME (CAS# CAS NUMBER) in CARRIER CHEMICAL NAME (CAS# CAS NUMBER) carrier or a POSITIVE CONTROL CHEMICAL NAME (CAS# CAS
NUMBER) positive control through a(n) EXPOSURE TYPE exposure route. The reported chemical concentrations are the result of METHOD analysis of chemical solutions
and are based on the IONIC FRACTION ion.  The EXPOSURE MEDIA was comprised of SOIL SAND MEAN (MIN-MAX)% sand, SOIL SILT MEAN (MIN-MAX)% silt, and
SOIL CLAY MEAN (MIN-MAX), % clay, pH PH MEAN (MIN-MAX), and SOIL ORGANIC MATTER MEAN (MIN-MAX)ORGANIC MATTER UNITS ORGANIC MATTER TYPE ,
SOIL MOISTURE MEAN (MIN-MAX)% moisture and SOIL CEC MEAN (MIN-MAX) UNITS CEC.  The concentrations are based on BASIS OF MEASUREMNT DRY-WET soil
weight and are the result of SOIL CONCENTRATION MEASURED analysis of the chemical concentration in soil.   (Reference REFERENCE #, AUTHOR, PUBLICATION
YEAR, TEST NUMBER, Documentation Code = DOCUMENTATION CODE).

Effect of CHEMICAL NAME (CAS# CAS NUMBER) on SCIENTIFIC NAME EFFECT The RESULT STATISTICAL METHOD FIELD is  inserted into the () of the min-max or +-value.

Effect
Measurement

Response Site  Obs.
Duratio

n

EXPOSU
RE 1

Mean
(Min-
Max)
OR 

(+-Value)
& Unit

EXPOS
URE 2
Mean
(Min-
Max)
OR 
(+-

Value)
& Unit

EXPOS
URE 3 
Mean
(Min-
Max)
OR 
(+-

Value)
& Unit

EXPOSU
RE 4

Mean
(Min-
Max)
OR 
(+-

Value)
& Unit

EXPOSU
RE 5

Mean
(Min-
Max)
OR 
(+-

Value)
& Unit

EXPOSU
RE 6

Mean
(Min-
Max)
OR 
(+-

Value)
& Unit

EXPOSU
RE 7 

Mean
(Min-
Max)
OR 
(+-
Value)
& Unit

ENDPOINT: Observation duration ENDPOINT  of  RESPONSE VALUE MEAN (MIN-MAX) UNIT on Measurement: EFFECT MEASUREMENT; Response
Site: RESPONSE SITE

Effect
Measurement

Response Site Obs.
Duratio
n Mean

(Min-
Max) OR

(+-
Value)
& Unit

RESPON
SE

VALUE
Mean
(Min-
Max)

OR (+-
Value)
& Unit

RESPO
NSE

VALUE
Mean
(Min-
Max)

OR (+-
Value)
& Unit

RESPO
NSE

VALUE
Mean
(Min-
Max)

OR (+-
Value)
& Unit

RESPON
SE

VALUE
Mean
(Min-
Max)

OR (+-
Value)
& Unit

RESPON
SE

VALUE
Mean
(Min-
Max)

OR (+-
Value)
& Unit

RESPON
SE

VALUE
Mean
(Min-
Max)

OR (+-
Value)
& Unit

RESPON
SE

VALUE*(
SIGNIF)
Mean
(Min-
Max)

OR (+-
Value)
& Unit

* LEVEL


